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While June’s meeting 
was lightly attended, 
no doubt because of 

beautiful weather, those who 
were there witnessed successful 
trouble shooting projects, and an 
informative series of videos on 
repairing laptop computers by 
author Scott Mueller.
Geof Goodrum helped Neal 
Grotenstein set up a Wifi wireless 
router for use with a laptop computer.  
Scott Hanak worked with Henry 
Kennedy to overcome an error 
message that appeared every time 
Henry booted his computer, and 
also worked on troubleshooting 
a printing problem.  Don Ferret 
brought in a laptop with several 
issues, including Internet Explorer 
freezing on closing.  With Scott 
Hanak’s assistance, that issue was 
resolved by removing Google and 
Yahoo toolbars.  Other problems 
were cured, or troubleshooting 
paths were suggested.
After the board of directors’ meeting, 
held now at Wegman’s dining room 
on the second level of the Fairfax 
store, the gang was able to verify 
that three memory modules worked 
properly, and installed two in Jim 

Brueggeman’s wide-screen Toshiba 
Satellite laptop.
Get A Free Digital TV at Our Next 
Meeting
Learn How to Convert Your 
Analog TV to Receive Free Digital 
Channels
Kurt DeSoto will discuss the Federal 
government’s mandate for TV 
stations to transition from analog 
to digital channels by February 17, 
2009, and what it means to viewers.  
Topics to be  covered include: (1) 
the differences between analog 
TV, digital TV, standard definition 
television, and high definition TV 
sets and broadcasts and how to 
determine the capabilities of your 
TV sets , (2) how to configure your 
existing analog sets to receive free 
over-the-air digital channels by 
using a converter box subsidized by 
the government, (2) how to submit 
an order online during the meeting 
(or later at your convenience) for up 
to two $40.00 coupons from the 
government to help defray the costs 
of the boxes, (3) when and how to 
connect the boxes  to your analog 
sets, and (4) how to keep getting 
low power analog channels, such 
as foreign language channels.  If 
time permits, Kurt will provide 

See PBits on page 2
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Lloyd’s Web Sites for July, 2008
by Lloyd Johnson, WACUG Member 

http://www.wacug.org/ is the URL for the Washington Area Computer 
User Group. Visit it for past issues of Web Sites with hyperlinks
1.	 MIT: OpenCourseWare–Want to look at MIT courses? http://ocw.mit.edu/Oc-

wWeb/web/home/home/index.htm OCW is a free publication of course materi-
als used at MIT.  OpenCourseWare shares free lecture notes, exams, and other 
resources from more than 1800 courses spanning MIT’s entire curriculum

2.  	 Yahoo! Shine –  http://shine.yahoo.com Yahoo! Shine is a new website for wom-
en.  The site offers nine categories ranging from Fashion & Beauty to Parent-
ing, and will feature content from many of the most popular lifestyles publish-
ers, including Conde Nast Publications and Hearst Corporation.

3.	 Project Gutenberg –  www.gutenberg.org/wiki/Main_Page Project Gutenberg 
is the Internet’s oldest producer of free electronic books, eBooks, or eTexts. 
There are over 20,000 free books in this collection

4. 	 Small Business Administration: Free Online Courses –   www.sba.gov/servic-
es/training/onlinecourses/index.html  Available courses are identified by topic.  
You can learn about the specific courses by clicking, ‘About these Courses.’  
In general, the courses are all self-paced and should take about 30 minutes to 
complete.  Most of the courses require a brief online registration.

5.	 FindLaw –  www.findlaw.com  FindLaw is the most comprehensive set of 
legal resources on the Internet for legal professionals, corporate counsel, law 
students, businesses, and consumers.

6.	 Respectfully Quoted: A Dictionary of Quotations –  www.bartleby.com/73   
2,100 entries in this collection of quotations.

7.	 How Recessions Work –  http://money.howstuffworks.com/recession.htm In 
this HowStuffWorks article, you will find out what recessions are, see why 
they occur, and examine the criteria economists use to identify them. Site 
also looks at the effects of recession as well as explores some of the ways a 
country can turn the economy around again.

8.	 U.S. Major Metro Newspapers – http://newslink.org/metnews.html  A listing 
of U.S. major metropolitan newspapers.

9.	 Understanding Your Telephone Bill –  www.fcc.gov/cgb/consumerfacts/under-
standing.html  The Federal Communications Commission’s (FCC) Truth-in-
Billing rules require telephone companies to provide clear, non-misleading, 
plain language in describing monthly services for which you are being billed.  
Here is a detailed description of some of the charges or line items that may ap-
pear on your traditional wireline telephone bill, your wireless telephone bill, or 
both.

 10.	 English Pronouncing Dictionary – www.howjsay.com  Enter the word you 
want and when it appears in pink, mouse over it to hear it spoken as often as you 
want. Each word is individually pre-recorded and no form of synthetic speech 
is used. Both American and British spellings are provided. Pronunciation is in 
Standard British English, with World English alternatives. Over 82,000 words 
listed.



NCTCUG
Visit our “sister” user group. 
The National Capital Tech-
nology and Computer User’s 
Group meets the first and 
fourth Wednesday of the 
month. They meet in Carlin 
Hall in Arlington at 5711 
South 4th Street. Visit their 
web site for more informa-
tion, a map and directions:

http://www.nctcug.org/
Meetings start at 7:00 PM

an actual demonstration of how 
to hook up a converter box to an 
analog TV set so the group can 
watch cartoons in digital format for 
the rest of the meeting, since it is 
Saturday after all.  Gosh.
Neal Grotenstein will provide a 
short discussion about protecting 
your email address from Internet 
email address harvesting programs.
(The following web page link to ac-
cess a list of Digital TV Stations re-
ceived in this area was inadvertently 
left out of last month’s “Keeping 
Up” column:  http://www.wacug.
org/recmtgs.html )



PBits continues from page 1
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See Linux  page 4

GNU/Linux SIG
By Geof Goodrum, WAC

Now Serving Wine (1.0)

After 15 years of development, the 
Wine Project released stable versi-
on 1.0 on June 17. 2008 (v1.1.0 was 
released on June 27th). As described 
by the Wine web site (http://www.
winehq.org/), “Wine is a translation 
layer (a program loader) capable of 
running Windows applications on 
Linux and other POSIX compa-
tible operating systems. Windows 
programs running in Wine act as 
native programs would, running 
without the performance or memo-
ry usage penalties of an emulator, 
with a similar look and feel to other 
applications on your desktop.” For 
example, when a Windows program 
requests user input, Wine substitu-
tes an equivalent X-Window Sy-
stem function for the Microsoft® 
Windows® OS function.
While GNU/Linux has excellent 
open source replacements for most 
common Windows applications 
such as web browsers and office 
suites, there are niche applications 
and games that are not available for 
Linux. Wine allows users to transi-
tion to GNU/Linux while bringing 
their favorite Windows programs 
with them. Wine works with DOS 
programs as well as 16 and 32 bit  

programs from Windows 3.1 to XP. 
The Wine Project plans to support 
64 bit Windows applications in the 
future.
While not every Microsoft Win-
dows software runs well under 
Wine, a wide variety of games and 
productivity applications do.  The 
Wine Project maintains a commu-
nity database of application compa-
tability reports and configuration 
advice at http://appdb.winehq.org/. 
There are also commercially sup-
ported versions of Wine that are 
optimized for various programs, 
such as CodeWeavers (http://www.
codeweavers.com/) and the closed 
source Cedega Gaming Service 
(http://www.cedega.com/).

GNU/Linux Distribution 
Releases
GNU/Linux distributions are com-
plete GNU/Linux operating system 
and application software collections. 
Many are freely downloadable or 
can be ordered on CDs or DVD at 
low cost. DistroWatch.com lists the 
following distribution release an-
nouncements for the period June 5 
– July 2, 2008.

Distribution
64 Studio 2.1
Arch Linux 2008.06
ArtistX 0.5
CentOS 5.2
Damn Small Linux 4.4
eAR OS 1.10
Finnix 92.0
GoblinX 2.7 “Mini”
Greenie Linux 3.0.2H
Kurumin NG 8.06
Linux Mint 5
MilaX 0.3.1
Molinux 4.0
Myah OS 3.0 “Box”
Myah OS 3.0 “Dragon”
Network Security Toolkit 1.8.0
NexentaCore Platform 1.0.1
openSUSE 11.0
Pardus Linux 2008
Parsix GNU/Linux 1.5r0

Pioneer Linux 3.2
Sabayon Linux 3.5
Scientific Linux 5.2
sidux 2008-02
StartCom Enterprise Linux 5.0.2
SystemRescueCd 1.0.4
VectorLinux 5.9 
Voltalinux 2.1
Zenwalk Linux 5.2
Zenwalk Live 5.2

Linux Software of the Month
The software described below is 
downloadable at the links provided 
or may be requested on CD. In addi-
tion, WAC can provide CD-R and 
DVD±R media for any download-
able GNU/Linux operating system 
distribution (e.g. Fedora, Mandriva, 
Ubuntu, Debian, Knoppix). Please 
note that download versions of 
commercial distributions do not in-
clude official technical support nor 
printed documentation.
Discs are available only by pre-or-
der. Contact Geof Goodrum by e-
mail (linux@wacug.org) at least 48 
hours before meeting day to order or 
for more information. Single CD-R 
discs are available with a $3 dona-
tion; GNU/Linux distributions on 
multiple CD-Rs or single DVD±R 
are available with a $6 donation.
July 2008
Floola - v3.0. http://www.floola.com/. 
Freeware executable by Tomas Camin. 
Floola is an application to efficiently 
manage your iPod or your Motorola 
mobile phone (any model supporting 
iTunes) under Linux, Mac OS X, and 
Windows. It can be run directly from 
your iPod and needs no installation. It 
supports all commonly used iPod fea-
tures including photos, artwork, pod-
casts, and smart playlists. It automati-
cally converts any incompatible audio or 
video file so that you can copy almost 
any file to it. It even allows adding 
YouTube and MySpace videos with 
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Linux from page 3

See Trying Linux page 5

a single click.

Freenukum – v.0.2.6. https://launch-
pad.net/freenukum/. Free GNU Ge-
neral Public License source code by 
the Freenukum Team. The Freenu-
kum Jump‘n Run game is a clone 
of the old EGA graphics based 2D 
game Duke Nukem. It uses the ori-
ginal Duke Nukem level and gra-
phics files.

Geotag – v0.055. http://geotag.
sourceforge.net/. Free GNU General 
Public License source code by Pablo 
d‘Angelo. Hugin is a toolkit for stit-
ching digital photographs and as-
sembling panoramas, together with 
an easy to use graphic front end.

Nload – v0.7.2. http://www.roland-
riegel.de/nload/. Free GNU General 
Public License source code by Ro-
land Riegel. nload is a console appli-
cation that monitors network traffic 
and bandwidth usage in real time. It 
visualizes the in and outgoing traf-
fic using two graphs. It also provi-
des additional information, such as 
the total amount of transfered data 
and the min/max network usage.

Kernel Source – http://www.kernel.
org/. 2.6 kernel source code for all 

platforms (stable 2.6.25.9 and pre-
patch 2.6.26-rc8).



For Anybody Who 
Has Thought About 
Trying Linux

By Drew Kwashnak, Linux SIG 
Leader, Danbury Area Computer 

Society, CT
www.dacs.org

dacseditor(at)dacs.org

For anybody who has thought 
about trying Linux, it has 
become easier than ever be-

fore with Ubuntu 8.04 LTS Hardy 
Heron. As with most Linux dis-
tributions, Ubuntu is available as a 
free download and is freely distrib-
utable. it is even available alreadyin-
stalled on Dell computers. 
The most common method is down-
loading the ISO image from Ubun-
tu’s website (http://www.ubuntu. 
com) and burning it onto a CD.
From the site, you can download the 
Desktop version or Server for 32-bit 
and 64-bit systems. There is even an 
option to download what is called 
an alternative version which is just 
the installer and does not include 
the LiveCD portion, which also 
includes an installer. If you are like 
me, until a couple months ago, and 
living on dial-up or you do not have 
a CD burner handy or just don’t 
want to put in that much effort then 
you can order a free CD through 
the corporate sponsor of Ubuntu, 
Canonical, ShipIt department.
I have been very pleased with the 
speed with which their CDs arrive. 
Alternatively, the website contains 
links to vendors where you can buy 
the CDs from under $5 to more, 
and they can handle large orders as 

well. 
Once you have your CD in your 
hot little hands, trying Ubuntu is 
as simple as placing it in your CD-
ROM tray and rebooting your sys-
tem. If system will boot from the 
CD and after a short moment you’ll 
be greeted with the Ubuntu wel-
come screen.
If you want to “try before you buy,” 
then you can choose the default “Try 
Ubuntu without any changes to 
your computer” and your hard drive 
will not be touched during your ses-
sion unless you choose to. You don’t 
even need a hard drive to select this 
option; you just will not be able to 
install it from the session.
If you are more certain or just dar-
ing then you can go straight into the 
installer and in about 60 minutes 
(45 minutes if you know what Dif-
ferent Strokes For Anybody Who 
Has Thought About Trying Linux 
by Drew Kwashnak you are doing) 
you’re booting to your new Ubuntu 
installation.
Ubuntu will scan your hardware 
and load the modules and drivers 
necessary for your system. If you 
have hardware that has proprietary 
drivers available, Linux cannot in-
clude them in the CD for legal rea-
sons. Ubuntu works around this by 
providing a Restricted Drivers tool 
that lists all such hardware found 
on your system and provides the 
ability to download and install the 
necessary drivers in a click or two, 
legally. 
Now that you have Ubuntu up and 
running on your system, what can 
you do? Plenty! Ubuntu brings you 
a fullfeatured operating system 
complete with:
• Firefox 3.05 beta web browser

https://launchpad.net/freenukum/
https://launchpad.net/freenukum/
http://geotag.sourceforge.net/
http://www.roland-riegel.de/nload/
http://www.roland-riegel.de/nload/
http://www.kernel.org/
http://www.kernel.org/
http://www.ubuntu. com
http://www.ubuntu. com
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Trying Linux from page 4

• OpenOffice.org 2.4 full featured 
office suite compatible with pre-Of-
fice 2007 Word, Excel, PowerPoint 
and some Access files.
• Evolution personal information 
manager for email and calendar 
goodness, a Microsoft Outlook user 
can feel comfortable with. There is 
even plug-ins to allow Evolution to 
access existing Microsoft Exchange 
servers.
• Pidgin multi-protocol instant 
messenger including Yahoo, MSN, 
AIM, Jabber, IRC and more.
• Gimp (GNU Image Manipulation 
Program), a powerful Photoshop-
like image editing program that 
includes filters, layers and a host of 
goodies.
• F-Spot image manager for cat-
egorizing and minor editing of all 
of your pictures as well as easily im-
porting pictures from your digital 
camera.
• And much, MUCH more…
If Ubuntu doesn’t come with a 
particular application, thousands of 
free applications are available from 
the Ubuntu online repository which 
are easily installed and updated from 
the Synaptic package manager. 
When you decide to install Ubuntu 
onto your hard drive or virtual ma-
chine you only need to click the 
“Install” icon on the desktop to start 
the process. After seven or so easy 
questions the installer will copy the 
files over to the hard disk. Depend-
ing on your system’s speed this could 
take about 60 minutes, more or less. 
It will even detect if you have Win-
dows installed and offer to transfer 
over your files and compatible set-
tings from your Windows accounts!
Of course, if the limitations of the 
LiveCD, such as settings are not 

saved from session to session, and 
you are hesitant to partition and 
install the full operating system on 
your hard drive Ubuntu offers yet 
another alternative called Wubi. 
Wubi is, from the Ubuntu website: 
“Wubi is an officially supported 
Ubuntu installer for Windows us-
ers that can bring you to the Linux 
world with a single click. Wubi al-
lows you to install and uninstall 
Ubuntu as any other Windows ap-
plication, in a simple and safe way. 
Are you curious about Linux and 
Ubuntu? Trying them out has never 
been easier!”
Wubi can be downloaded as an .exe 
file directly. With Linux the in-
stallation is not the end, only the 
beginning! Whether you try the 
LiveCD, Wubi or a full installation 
you will find a wealth of quality ap-
plications, refreshing freedom and a 
community unlike any other! If you 
have problems, questions or want to 
find out more then you need look no 
further than the third Wednesday of 
every month for the DACS Linux 
SIG at 7:30 p.m. in the DACS Re-
source Center!

Drew Kwashnak: Has been losing 
more nights of sleep with Linux 
since 2002 and just can’t keep from 
downloading and trying the latest 
versions! When not working with 
Linux he works with ASP.NET 
and Microsoft SQL Server for a 
small financial company.
He is also the DACS Linux SIG 
leader and a father of 3.
Links:
Ubuntu:
http://www.ubuntu.com

Get Ubuntu:
http://www.ubuntu.com/getubuntu

ShipIt:
https://shipit.ubuntu.com/
Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

This article has been provided to AP-
CUG by the author solely for publica-
tion by APCUG member groups. All 
other uses require the permission of the 
author (see e-mail address above).



Washington Area User Group Partners
Working Together For Our Members

CPCUG	 NCTCUG	 WACUG

http://www.ubuntu.com
http://www.ubuntu.com/getubuntu 
https://shipit.ubuntu.com/
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The Digital TV Dilemma?
Have Questions?

Not sure if your  
tv is ready for digital?

Special Workshop:
Entering the Digital TV World

Saturday, June 28
10:30 a.m., Room 229

Practical help on how to transition 
your analog TV to receive 

digital signals.
Certificates for conversion boxes 

will be available.
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Digital TV 
Dilemma? 

By Kurt DeSoto, WAC Member

Have Questions about the 
February 2009 change-
over to all Digital Broad-

casting?
Kurt DeSoto will discuss the Fed-
eral government’s mandate for TV 
stations to transition from analog 
to digital channels by February 17, 
2009, and what it means to view-
ers.
Topics to be  covered include: 

(1) the differences between analog 
TV, digital TV, standard definition 
television, and high definition TV 
sets and broadcasts and how to de-
termine the capabilities of your TV 
sets 
(2) how to configure your existing 
analog sets to receive free over-the-
air digital channels by using a con-
verter box subsidized by the govern-
ment, 
(3) how to submit an order online 
during the meeting (or later at your 
convenience) for up to two $40.00 
coupons from the government to 
help defray the costs of the boxes, 
(4) when and how to connect the 
boxes  to your analog sets, and 
(5) how to keep getting low power 
analog channels, such as foreign 
language channels.  If time per-
mits, Kurt will provide an actual 
demonstration of how to hook up a 
converter box to an analog TV set 
so the group can watch cartoons 
in digital format for the rest of the 
meeting, since it is Saturday after 
all.  Gosh.



Email Etiquette 
By John Roy, President, The PC 

Users Group of Connecticut
www.tpcug-ct.org/

johnroy1(at)comcast.net

Do you really know how to 
forward an e-mail? It is 
estimated that over fifty 

percent of email users do not know 
how to do it properly. Do you won-
der why you get viruses or junk 
mail? Email messages get forwarded 
countless times without concern for 
the security of the previous sender’s 
addresses. 
Every time you forward an e-mail 
there is information left over from 
the people who got the message 
before you, namely their e-mail 
addresses and names.  As the mes-
sages get forwarded along the list of 
addresses builds and builds creating 
a huge resource for spammers. All 
it takes is for someone to get a virus 
and the infected computer can send 
that virus to every e-mail address 
that has come across that comput-
er. Even if the address collection 
doesn’t result in a virus it surely will 
be harvested by spammers or some-
one looking to make a couple of 
cents for a listing of good email ad-
dresses. How do you stop or at least 
minimize the propagation of email 
addresses? There are several easy 
steps that we should all practice.
(1) Before you send out a forwarded 
e-mail, DELETE all of the other 
addresses that appear in the body 
of the message (at the top). That’s 
right, DELETE them. Highlight 
them and delete them, backspace 
them, cut them, whatever it is you 
know how to do. It only takes a sec-
ond You MUST click the ‘Forward’ 
button first and then you will have 
full editing capabilities against the 
body and headers of the message. 

If you don’t click on ‘Forward’ first, 
you won’t be able to edit the mes-
sage at all.
(2) Whenever you send an e-mail 
to more than one person, do NOT 
use the To: or Cc: fields for adding 
e-mail addresses. Always use the 
BCC: (blind carbon copy) field for 
listing the e-mail addresses. This is 
the way the people you send to will 
only see their own e-mail address. 
If you don’t see your BCC: option 
click on where it says To: and your 
address list will appear. Highlight 
the address and choose BCC: and 
that’s it, it’s that easy. When you 
send to BCC: your message will au-
tomatically say ‘Undisclosed Recip-
ients’ in the ‘TO:’ field of the people 
who receive it.
(3) Remove any ‘FW:’ in the subject 
line. You can re-name the subject if 
you wish or even fix spelling. 
(4) ALWAYS hit your Forward 
button from the actual e-mail you 
are reading. Ever get those e-mails 
that you have to open 10 pages to 
read the one page with the informa-
tion on it? By forwarding from the 
actual page you wish someone to 
view, you stop them from having to 
open many e-mails just to see what 
you sent. 
(5) Have you ever gotten an email 
that is a petition? It states a posi-
tion and asks you to add your name 
and address and to forward it to 10 
or 15 people or your entire address 
book. The email can be forwarded 
on and on and can collect thousands 
of names and email addresses. A 
FACT: The completed petition is 
actually worth a couple of bucks 
to a professional spammer because 
of the wealth of valid names and 
email addresses contained therein. 

See E-mail Etiquette page 8
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See E-Mailing Photos page 9

APCUG member groups.

This article has been provided to 
APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).



If you want to support the petition, 
send it as your own personal letter 
to the intended recipient. Your po-
sition may carry more weight as a 
personal letter than a laundry list of 
names and email address on a peti-
tion. (Actually, if you think about it, 
who’s supposed to send the petition 
in to whatever cause it supports? 
And don’t believe the ones that say 
that the email is being traced, it just 
isn’t so!) 
(6) One of the main ones I hate is 
the ones that say that something 
like, ‘Send this email to 10 people 
and you’ll see something great run 
across your screen.’ Or, sometimes 
they’ll just tease you by saying 
something really cute will hap-
pen IT AIN’T TRUE, IT’S NOT 
GONNA HAPPEN!!!!! (Trust me; 
I’m still seeing some of the same 
ones that I waited on 10 years ago!) 
I don’t let the bad luck ones scare 
me either, they get trashed. (Could 
that be why I haven’t won the lot-
tery?) 
(7) Before you forward an Amber 
Alert, or a Virus Alert, or some of 
the other ones floating around now-
adays, check them out before you 
forward them. Most of them are 
junk mail that’s been circling the net 
for Years! Just about everything you 
receive in an email that is in ques-
tion can be checked out at Snopes. 
Just go to http://www.snopes.com/. 
It’s really easy to find out if it’s real 
or not. If it’s not, please don’t pass 
it on. 
So please, in the future, let’s stop or 
at least minimize the junk mail and 
the viruses by taking the steps out-
lined above.
Obtained from APCUG with the 
author’s permission for publication by 

E-mail Etiquette from page 8

E-Mailing 
Photographs

By Richard Kennon, Editor, 
Amador Computer Users Group, 

CA
www.acug.net

Drtrdguy(at)volcano.net

First, we must understand that 
photograph (image) size in 
the camera and in the com-

puter is measured in pixels. These 
are the basic dots of color that make 
the picture. Do not pay any atten-
tion to anything that says “inches” 
or “pixels per inch.” These terms are 
meaningless when we are consider-
ing a picture either in the camera 
or in the computer. They may come 
into play later if we want to print 
the photo on paper. But, that is an-
other subject for another time. For 
now, we think only of pixels. Most 
cameras record too many pixels to 
e-mail. For instance a 6 megapixel 
camera will make a picture about 
3000 pixels wide by 2000 pixels 
tall and the file size may be several 
megabytes. Our screens are usually 
only about 1000 pixels wide (some 
are larger and some smaller). So, if 
we e-mail the native picture, it will 
be wider than the screen for the re-
cipient and the file will be so large, 
it may take “forever” to download to 
the recipient’s computer. It is pos-
sible the service provider will not 
even accept it.
There are two things we must do 

to make a photo e-mailable. The 
first is to resize or resample the pic-
ture. We want to change the pic-
ture width from 3000 pixels to 800 
pixels, for instance. This process is 
called resizing or resampling. We 
have to pick the best 800 pixels out 
of the 3000 to represent our photo. 
Well, no, that is not exactly correct 
but it simplifies things to think of 
it that way. We don’t have to worry 
about it because a lot of very smart 
programmers have developed ways 
(algorithms) to help us. Just remem-
ber, you want to resize or resample 
to get the photo down to a size con-
venient for e-mailing. I usually use 
800 pixels or 900 pixels width for 
pictures I attach to e-mails. (See im-
age 1 on page 10)
The second thing to do to make a 
photo e-mailable is to save it in 
JPEG format (.jpg). That is a for-
mat that reduces file size a lot and 
picture quality a little so the picture 
can be downloaded more quickly 
and still be nice to look at. Some 
software programs give you choices 
of compression amount with num-
bers ranging from 1 to 10. One will 
result in a very small file but the pic-
ture quality will not be good at all. 
A 10 will give the very best quality 
but with a very large file size. A rea-
sonable compromise is to use 5 or 6. 
I usually use 6.
How do you do this? First, I will 
describe how to do it with a free 
Microsoft program. Then I will try 
to look at some other programs.
Microsoft Power Toys for XP has 
a Resize Pictures toy that is slick 
and easy but feedback says it only 
works on XP. It can be downloaded 
at http://www.microsoft.com/win-
dowsxp/downloads/powertoys/xp-
powertoys.mspx. Right click on an 

http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx
http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx
http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx
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E-Mailoing Photos from page 8 There are many other editing pro-
grams that I haven’t mentioned and 
have no experience with. In all cases 
you want to change the picture’s size 
in pixels by resizing or resampling. 
Pay no attention to anything that 
says “inches” as that will have no 
meaning for this process. Sometime 
later we will talk about printing pic-
tures and then we will use inches.
Obtained from APCUG with the 
author’s permission for publication 
by APCUG member groups.
This article has been provided to 
APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).


Screenshots for this article appear 
on the following page — Editor

image name or thumbnail in Ex-
plorer or My Computer and choose 
Resize Pictures. You are limited to 
four specific sizes but they are good 
choices. They don’t tell us what 
compression they are using but the 
results look OK. Unless you tell 
them under Advanced to replace 
the image in the file, it will make 
a copy. That’s good. They will add 
the word, “Large”, “Medium” or 
“Small” to the end of the name you 
have chosen.
If you are happy with this solution, 
then read no further. But, if you 
want to use a picture editing pro-
gram, maybe this will help.
In Photoshop Elements 5, click on 
Image>Resize>Image Size and 
this window will pop up. Note 
that there is some garbage at the 
bottom about “inches” but we will 
ignore that. First we will click the 
Resample Image box. That puts the 
Pixel Dimensions in play and that is 
what we want. I selected the Width 
box and changed the width to 800 
pixels. Since the Constrain Pro-
portions box is selected, that is all I 
have to do. (See image 2 on page 10)
Note, down at the bottom, that we 
have several choices of sampling al-
gorithms. This is frosting on the cake. 
I read somewhere that I should use 
Bicubic Sharper when downsizing 
so that is what I do.  (See image 3 on 
page 10) Most programs don’t give 
us all these choices. Then we should 
click on File>Save As and give the 
photo a new name. I often just use 
the same name and add “_800px” so 
the next time I will know it is ready 
to e-mail. Here we can choose the 
JPEG format and the compression 
amount. Photoshop Elements 6 is 
out now and sells for about $100. If 
you are able to spend that much and 

want one of the best editing pro-
grams, I highly recommend it. (See 
image 4 on page 10)
Let’s look at Picasa2. It is a free pro-
gram from Google and looks really 
good but I do not have much experi-
ence with it. By all means, try it first 
because the price is right! When it 
comes to e-mailing photographs, it 
is a little more automated but not 
any easier to use than Elements. 
First, click on Tools>Options>E-
Mail. Then select the width you 
want in pixels. There are six choices. 
Then click on Apply and OK. (See 
image 5 on page 10)
The next step is to click on File>E-
Mail and you will get three choices 
of how you want to e-mail your 
photos. Fortunately, I use Outlook 
Express so my choice is listed.
When I clicked on Outlook Express, 
an e-mail page popped up with the 
photo attached. At this point we can 
write something else on the e-mail 
and send it. I recommend this so the 
recipient will know it is really from 
you and not something sent out by 
a virus. When I receive e-mails that 
only say “Attached”, I Delete them 
without looking at the attachment. 
This saved me one time when I re-
ceived a virus from my sister-in-law 
that she did not know she sent. She 
spent weeks and dollars getting her 
computer back up. Oh, I digress. 
If you want to send more than one 
picture (and, who doesn’t?), you 
must select the picture and click on 
the Hold button near the bottom of 
the screen. Do this for each photo 
you want to send and they will all be 
attached to the e-mail. The program 
automatically chooses JPEG format 
and a compression ratio but does not 
tell you. That is OK as the pictures I 
tried looked good. Picasa2 has con-
siderable capability for editing pho-
tos in many respects. Try it!



The Cursor —  July  19,  2008 Page 10  — www.wacug.org

Image 1

Image 2
Image 3

Image 4
Image 5



The Cursor —  July 19,  2008 Page 11  — www.wacug.org

The Cursor
	 Copyright ©2008 WACUG	 Monthly Circulation: 100

The 2007 WAC Board of Directors, SIG Leaders and other Volunteers
	 Directors:
President:........................................................ Paul Howard, 703-860-9246, plhoward(at)verizon.net
Vice-President:............................................... Geof Goodrum, 703-370-7649, ggoodrum(at)bigfoot.com
Secretary:........................................................ Bill Walsh, 703-241-8141, bill.walsh(at)cox.net
Treasurer:....................................................... Bob Rott, blbob1b@verizon.net
Director Emeritus: ........................................ Lu Spriggs, 843-467-9022, luspriggs(at)aol.com
Newsletter Editor........................................... Chuck Rogerts, 703-876-9787, chrobe(at)cox.net
Registered Agent:........................................... Jorn Dakin, 703-534-8691, Idakin(at)alumni.uchicago.edu
PC Software Team:........................................ Jim Brueggeman, 703-450-1384, bigjimo1(at)aol.com
PC Software Team:........................................ Bob Mason, 703-503-9324, Bob.Mason(at)remjem.com
Member at Large:...........................................  Mel Mikosinski, 709-978-9158, melvin22003(at)aol.com
	 Volunteers
Linux SIG Leader, Membership Chair:........ Geof Goodrum, 703-370-7649, ggoodrum(at)bigfoot.com
Internet Columnist:....................................... Lloyd Johnson, lloydhj(at)aol.com
Vendor Contact:............................................. Chuck Roberts, 703-876-9787, chrobe(at)cox.net
Web Site Team: .............................................. Paul Howard and Chuck Roberts
Meeting Setup/APCUG Liaison:................. Bill Walsh, 703-241-8141, bill.walsh(at)cox.net

Send membership inquiries and address changes to: membership@wacug.org
Send article submission and reprint requests to the Editor: cursor@wacug.org

WAC Membership/Renewal Application

Dues are collected on an Annual basis and includes: 
downloadable links for WACUG Selected Software 
(formeraly DOM), and WAC’s monthly newsletter, 
The Cursor, in PDF format
Individual/Corporate/Family Dues: $25.00  
$12 annual surcharge for delivery of the Cursor by 
1st Class mail
Remit payment in person at the WAC Membership 
table on meeting day, or by mail to:
Washington Area Computer User Group
30 Fendall Ave.
Alexandria, VA 22304-6300
Make checks payable to WAC. Please do not send 
cash by mail.   Thank you for joining WAC!
Complete if you name and address do not appear 
on the reverse side. Include E-mail Address
Name:
Street:
City:
State:			   Zip:
Phone:  (        )          –

E-mail: 
Membership Survey: Help us to help you by completing this survey.
List the computer systems you own / use (in order of preference)

Operating System(s):

Modem(s):

Printer(s):

Other Hardware:
Favorite Software:
Connection: (circle one) 	 Dial-up     or  	 Broadband

Circle Your Interests:	 Photo Printing	 Investing	 Games
Digital Photography	 Internet Access	 Education	 Music
Graphics/Animation	 Genealogy	 Video	 Finance
Programming Language(s)
Hardware Upgrades/Repair	 List others below

The Cursor is the official publication of the Washington Area Computer User Group (WACUG), a Virginia membership corporation. WACUG 
is a tax exempt organization under section 501(c) (3) of the Internal Revenue Code. Contributions are encouraged and are tax deductible. All 
material is Copyright © 2008 by the Washington Area Computer User Group unless otherwise specified. Products or brand names mentioned 
may be trademarks or registered trademarks of their respective owners. The contents of articles herein are the responsibility of the authors and 
do not necessarily represent the Washington Area Computer User Group, the Board of Directors, or its members.
The Cursor provides news, commentary and product information to members of the Washington Area Computer User Group.



Washington Area Computer User Group
30 Fendall Avenue
Alexandria, VA 22304-6300

ADDRESS CORRECTION REQUESTED

FIRST-CLASS MAIL

Label

Stamp

September Meeting will be  
held at the Fairfax County 

Government Center
Fairfax, VA

Go through front door 
about 25 feet then follow 
sign to the Meeting Room 

on the right

Service Desks Open at 
12:30 Meeting Starts at 

1:00 PM
FREE ADMISSION
BRING A FRIEND!

Next WAC Meetings:	  • Aug 16	 • Sept 13	 • Oct 18	 • Nov 22	 • Dec 13

Call (703) 370-7649 for the latest meeting information or Visit our Web Site at:
http://www.wacug.org 

TIME-SENSITIVE MATERIAL
Please Deliver By

July 11, 2008



The Cursor —  July 19,  2008 Bonus Page �  — www.wacug.org

The New, The Best, 
and The Worst - 
May 2008

Collected by Pim Borman, 
Webmaster, SW Indiana PC Users 

Group
swipcug.apcug.org

swipcug(at)gmail.com

Tales of Woe
Sorry, Folks, but this 
month I can’t think of any 

New and/or Best to report on, only 
Troubles, with a Capital ‘T.’So let’s 
get started.
Spinrite 6.
Son Mike’s computer recently re-
fused to boot, and his main concern 
was the potential loss of some recent 
data files that he had not yet backed 
up. Regrettable, but it happens to 
the best of us - literally. The local 
school system lost all the students’ 
test results of the current term be-
cause the computers crashed. The 
data were not securely backed up. 
Whom to blame? No one other 
than the operator, IBM, symbol of 
computing excellence. According to 
the local paper, the IBM represen-
tative claimed that this had never 
happened before and could not be 
explained. Sound familiar?
Back to Mike. When it was clear 
that he could not boot from the 
hard drive, not even in safe mode, 
the next step was to use a Windows 
XP setup disc and use its Repair 
function. Windows labored might-
ily, trying to repair his drive, but 
kept getting bogged down with a 
variety of obscure error messages. 
At one time he got a DOS prompt 
that allowed him to list the files on 
his computer, but when he tried to 
copy them he was denied access. 
When we booted his computer with 
a Live Ubuntu Linux CD he could 
also see his precious files, but access 

was again denied.
There is a lesson to be learned from 
this. The Windows XP operating 
system runs on a partition config-
ured in the NTFS format. When 
data files are saved in that format, 
Windows XP (and Vista) by default 
protect those files from access by 
others. That is a nice safety feature 
for those who really need it, but it 
makes the data unavailable over 
your network, or evidently even 
from a DOS prompt. You can be-
forehand designate specific data 
files to be shared, but it is a lot of 
bother, easily forgotten. Here is 
the lesson: store all your data files 
on a separate partition set up in the 
older FAT32 format, and they’ll be 
available whenever and wherever 
you need them. Even better, also 
back them up to an external drive in 
FAT32 format.
At this point I remembered reading 
about a terrific file recovery pro-
gram, Spinrite 6, available for $89 
from Gibson Research Corpora-
tion, owned and operated by Steve 
Gibson, the well-known computer 
guru (www.grc.com). We down-
loaded the program and converted 
it to a bootable disc. After booting 
Mike’s computer with the Spinrite 
disc it immediately announced that 
his drive was subject to imminent 
failure. Well, that’s what we spent 
the $89 for. We started the file re-
covery mode, with a warning that 
this could take a looong time, think 
24 hours or so. 
Several days later, after running 
something like 60 hours during 
which the program every so often 
would get bogged down and had 
to be restarted, the program had 
progressed to 93% completion 
and refused to go any further. 
No indication that any files were 
available to be recovered.

Mike installed Windows XP on 
a new drive and put the old wreck 
in an external hard drive enclosure 
connected to a USB port of his com-
puter. The old drive was unreadable 
at this point. Still unwilling to give 
up, Mike tried the old standby, 
Windows’ checkdisk with the /F 
parameter (for “fix”) to let Windows 
try to repair salvageable parts of the 
drive. It worked! After several re-
peats of the procedure he was able 
to recover most of his lost files that 
meanwhile also had become acces-
sible. So much for Spinrite, mark 
one up for good old DOS.
Acronis
After creating the Spinrite disc, and 
before using it on Mike’s computer, 
I tested it on my desktop computer 
by doing a routine check of my hard 
drive, expecting it to be in perfect 
shape. To my surprise Spinrite 
halted about 5% into the inspection 
because the hard drive was over-
heating. Newer serial (SATA) hard 
drives are equipped with a SMART 
program that reports many operat-
ing parameters of the drive. Win-
dows can’t read SMART, but Spin-
rite can. On inspection I found that 
the cooling fan for the hard drive 
compartment was kaput. It was eas-
ily replaced by the local people who 
built my computer, but even then 
the drive continued to overheat, a 
clear warning that it may fail any 
time.
I bought a new 500 GB Maxtor drive 
(on sale for $99!) which came with a 
utility, “MaxBlast” to copy an exact 
image of my setup to the new disc, 
avoiding the necessity to reinstall 
everything. The way it wanted to go 
about it was to do a three--way par-
tition of the 500 MB drive, similar 
to the 3 partitions in the old (250 

 See New, Best, Worst next page
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MB) drive, but twice as large. It was 
going to copy everything on the old 
drive to the new drive, including my 
Linux programs in their partition, 
with the warning that the Linux 
system would no longer be bootable. 
That was not what I had in mind, I 
just wanted to copy an image of the 
C: partition from the old to the new 
drive. Since MaxBlast turned out to 
be version 10 of disk manager Ac-
ronis, I gave Acronis-11 a try in the 
hope that it would be more flexible. 
I uninstalled MaxBlast and tried to 
install Acronis 11, but it balked. I 
tried to remove all traces of Max-
Blast from the Registry, but Acronis 
still wouldn’t install. I uninstalled 
as much as possible of Acronis and 
tried to reinstall MaxBlast. No luck; 
darn. So much for Acronis.
After clean installations of Windows 
XP and Ubuntu Linux on the new 
drive, Windows could not find my 
Internet connection. After strug-
gling several days I finally realized 
that my motherboard needed to be 
software-configured and that I did 
not have the correct drivers. Thanks 
to the local availability of the guys 
who originally built the system I got 
the correct drivers and all was well. 
Ubuntu never had any problem. It 
downloaded and installed the re-
quired Linux drivers automatically.
Ubuntu
Windows Vista is not the only op-
erating system with compatibility 
problems on installation. Ubuntu 
and other Linux distributions have 
more than their share of installation 
problems. Most of these appear to 
be due to proprietary graphics sys-
tems for which Linux has no driv-
ers (yet). I have been recommending 
for years that people ought to start 

using Linux, but on both occa-
sions where I convinced someone, it 
turned out that Ubuntu was incom-
patible with their systems. Com-
puters with integrated graphics and 
many laptop computers have low-
cost proprietary hardware (made in 
China) that is attuned to Windows, 
but unlikely to have Linux drivers. 
Standard graphics cards from ma-
jor manufacturers are more likely 
to have Linux drivers available, and 
those based on the NVidea chip set 
have Linux support from the manu-
facturer. 
You can try to run Ubuntu from 
the CD-ROM without installing it 
on the hard drive, a so-called “live” 
installation. If that works, your 
system is probably compatible and 
you can proceed with a permanent 
installation. If it doesn’t work, not 
much is lost since the distribution 
is free. In any case, Linux is a large 
program and requires at least 256 
MB of RAM and 10 GB of hard 
drive space.
Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.

This article has been provided to AP-
CUG by the author solely for publica-
tion by APCUG member groups. All 
other uses require the permission of the 
author (see e-mail address above).



From My Vista
by Rob Limbaugh, President, 

Danbury Area Computer Society, 
CT

www.dacs.org
relimbaugh(at)dacs.org

Just about every year I make some 
sort of ‘major’ effort to move for-

ward with technology in some way 
on my primary home workstation. I 
periodically wipe out the machine 
and start a fresh OS install from 
scratch. I reasoned that as laborious 
a reinstall is, I may as well bite the 
bullet and this time make the move 
to Vista. What made the timing 
right was that Microsoft gave Win-
dows Vista Ultimate 32-bit w/SP2 
for those who attended the APCUG 
2008 LDC. Here’s my experience.
Check Compatibility
When loading an OS it is impor-
tant to make note of your hardware 
and key software. Vista Update Ad-
visor will highlight any hardware 
or software compatibility issues of 
which to be aware. In my case, the 
only issues to address were applica-
tions that would be replaced with 
new Vista versions—no big deal. 
In terms of hardware, my machine-
checked out OK. Last I had heard, 
my ATI All-In-Wonder 2006 video 
card was not yet supported in Vista, 
so I double checked the AMD (they 
now own ATI) website and con-
firmed there are now Vista drivers 
and software. It’s a Go!
Backup Data
Next, I made backups of all my 
important data. This time around 
I used an external USB hard drive 
and just dragged and dropped the 
data to a ‘backup’ folder. I wanted 
to start fresh and clean, so I didn’t 
bother making a backup of my Win-
dows or Office user settings. There 
aren’t any new BIOS updates for my 
motherboard, so I was all set to go.
Time for Install
I started the install process around 8 
p.m., electing to wipe all partitions 
on the hard drive. My first boot to 

See My Vista next page
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My Vista from previous page

the desktop post install was shortly 
after 10 p.m. So far, so good. And, 
considering this is a P4 2.4GHz 
machine, I was rather impressed. 
Vista’s graphics worked from the 
get-go because the ATI All-In-
Wonder 2006 uses an ATI Radeon 
9600 compatible chipset for which 
Vista loaded drivers. Sound worked. 
Networking worked. I expected 
SOMETHING to be wrong, due 
to all the horror stories I had heard! 
My machine even received a 3.2 on 
the “Vista Experience Index”. That 
means I can use
Aero! Now we’re cooking!
Post Install Issues
A notice appeared that Windows 
detected hardware and needed to 
install drivers. My system’s moth-
erboard has an integrated Realtek 
AC’97 sound card. Unfortunately 
there isn’t a Vista driver for the 
MIDI interface. If I want to hook 
up MIDI devices in the future, I will 
probably need to disable the built-in 
sound card and install a properly 
supported one to gain MIDI inter-
face functionality. 
Watching TV is one of the things 
for which I built this machine, and I 
expected to use Vista Media Center. 
This is where my second issue came 
up. While AMD (they bought ATI) 
has released updated Vista driv-
ers and software for the ATI AIW 
2006 video card, they didn’t actu-
ally ‘fix’ the issue with how the ATI 
Hydravision software accesses the 
TV Tuner. I searched around for a 
solution and came across a Home 
Theater application called “Beyond 
TV” by SnapStream. So far that 
seems to solve my issue. Beyond 
TV has a ton of cool features (worth 
looking at even if you aren’t going 

to Vista).
Reality Check
In my consumer opinion, lack of 
proper drivers for an OS is the fault 
of the hardware integrator and not 
the OS maker. AMD is blaming 
Microsoft’s changes in DirectX 
10 D3D (which happen to address 
performance and security) as why 
the ATI TV Tuner software doesn’t 
work. Well, AMD, how come Snap-
Stream could figure it out? AOpen 
has not released any new drivers for 
their implementation of the AC’97 
chip on my motherboard. I can live 
with AOpen’s choice because most 
people don’t use the MIDI inter-
face feature of sound cards. AMD 
has no excuse for not supporting an 
expensive video card that is bought 
for the very feature they aren’t sup-
porting. My buying habits will be 
adjusted accordingly in the future.
Supporting Apps
Along with Beyond TV, I installed 
what I consider ‘Base Supporting 
Apps’. These included Avast! An-
tivirus, Notepad++, Pidgin, Adobe 
Reader, Adobe Flash Player, Adobe 
Shockwave Player, TrueCrypt, Pri-
moPDF, and WinSCP. Office Ulti-
mate 2007 is going to round out the 
Office Suite. Everything installed 
smoothly. No issues, arguments, or 
contentions between apps.
Where I Stand 
My machine has paid its dues many 
times over and the driver issues 
didn’t affect my ability to use what 
I needed, so I was OK with that. 
Others with more particular needs 
should be aware that integrated 
soundcards, atypical hardware, old 
devices, and fancy graphics capture 
cards may require special attention. 
Replacements may need to be con-
sidered. I’m not suggesting every-
one run out and install Vista. This 

is now the fourth time I’ve installed 
Vista on a machine—first time on 
one I plan to use regularly. All said 
and done, the experience has been 
pleasant and not anything like the 
horror stories I’ve heard. At the 
time of this writing it’s been about 
two weeks and all continues to work 
well. This article was typed on that 
system using Word 2007 and sent
to the editors with Outlook 2007. 
From my vista, Vista works just 
fine.
Vista Upgrade Advisor:
http://www.microsoft.com/win-
dows/p r o d u c t s / w i n d o w s v i 
s t a /buyorupgrade/upgradeadvisor.
mspx
Compare Vista Editions:
http://www.microsoft.com/win-
dows/products/windowsvista/edi-
tions/choose.mspx
SnapStream Beyond TV:
ht t p: //w w w.snaps t rea m.com /
products/beyondtv/
Obtained from APCUG with the 
author’s permission for publication by 
APCUG member groups.
This article has been provided to 
APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).
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I’M ASKED...
By Bill Funk, a member of the 

Arizona Association for Computer 
Information, inc. (ASCIi)

www.asciigroup.org
editor(at)asciigroup.org

Obtained from APCUG with the 
author’s permission for publication 

See Asked next page
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by APCUG member groups.
I just bought a Digital SLR; with 
the prices as low as they are, I 
couldn’t resist.
Since I want to take photos of my 
grandchildren, and the built-in 
flash isn’t as powerful as I need, I 
bought a new flash. It’s the same 
brand as my camera, and is sup-
posed to be all automatic. But, the 
photos aren’t right. I thought the 
better flash would let me take pho-
tos inside, and freeze the movement 
of the grandkids, but the photos are 
as blurry as with the camera’s flash.
What’s going on?
You’re right, the on-board flashes 
on most DSLRs aren’t very bright. 
Buying the new flash is the right 
idea, but it doesn’t work the way 
many people think it does.
You’re probably using the camera as 
a Point & Shoot: setting the camera 
to make the exposure decisions, and 
pressing the shutter button. There’s 
nothing wrong with that, but doing 
things that way won’t get your flash 
to work the way you want it to.
Instead, you should use the Man-
ual mode for exposure (check your 
camera’s manual for how to enter 
the Manual mode). While you’re 
looking at the manual, check to 
find the highest shutter speed you 
can use with the flash, too.
Then, in Manual mode, set the shut-
ter speed at, or maybe slightly be-
low, that speed ( I use 1/125 sec on 
my camera; it’s fast enough to freeze 
most action), then set the aperture 
(f/number) for the desired result as 
far as depth of field is concerned, 
and set the ISO as desired. Set the 
flash to auto (check the manual), 
and fire away. This way, the cam-

era will use the settings you chose, 
ignoring the amount of light in the 
scene. The flash will check to see 
what the camera is set to, and fire 
itself, checking the results as it fires 
to give the right amount of light to 
the scene. Neat, eh?
The way you’re doing it will make 
the flash act as a “fill” flash, meaning 
the camera’s exposure system will 
use the existing light in the scene to 
set the exposure, and the flash will 
intelligently fire to fill in shadows, 
but not be the major source of light 
in the scene. This is also the usual 
way the camera’s on-board flash 
works, even though many cameras 
will set the shutter speed to take 
advantage of the flash’s extra light 
to help freeze motion. The problem 
here, though, is that the on-board 
flash just isn’t bright enough to light 
up a dark scene (such as a room) 
very well.
One of the really neat things about 
digital photography is that, regard-
less of the actual type of the cam-
era, experimentation is cheap. In 
this case, once you get the basics 
of flash use down, you can experi-
ment with different shutter speeds 
and aperture settings for different 
results. Also, off-camera flashes like 
yours will usually let you turn the 
flash head up and down, and side to 
side, for bounce flash. With bounce 
flash, you’re bouncing the flash off 
the ceiling or wall. This tends to 
spread the light from the flash out 
to reduce that sharp look that a 
straight-on flash gives, and it also 
reduces harsh shadows (as well as 
changing where the shadows are); 
more to experiment with!
This brings up another question: if 
you have an older flash from your 
film days, can you use it with your 
new DSLR? The answer is a very 
firm: maybe. The problem is that 

most older, film-era flashes have a 
higher trigger voltage than what 
DSLRs can tolerate. In other words, 
using that old flash can cause some 
expensive damage to your DSLR. 
There are some devices that can be 
put between your older flash and 
your DSLR’s flash shoe that will 
solve the problem. However, a new 
flash will also work much better with 
your new DSLR, and do things that 
old flash can’t even dream of doing.
This article has been provided to 
APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).
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